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INTRODUÇÃO 

Este tutorial objetiva a orientação de estudantes, para a confecção de um 

mapeamento geomorfológico. Será apresentado o referencial teórico-metodológico 

acerca da cartografação do relevo e os procedimentos operacionais realizados com o 

auxílio de técnicas de Geoprocessamento utilizando, principalmente, o programa 

ArcGIS 9.2 e de modo secundário, o ENVI 4.0, através de um passo-a-passo ilustrado. 

Tal trabalho é resultado de bolsa de iniciação científica, financiada pelo 

Programa Institucional de Bolsas do Ensino de Graduação – PIBEG e subsidiada pelo 

Laboratório de Geomorfologia e Erosão dos Solos – LAGES, ambos da Universidade 

Federal de Uberlândia. 
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1. FUNDAMENTAÇÃO TEÓRICO-METODOLÓGICA  

1.1. Cartografia Geomorfológica 

A ciência cartográfica constitui-se numa importante ferramenta para as Ciências 

da Terra (Geociências), pois compreende a representação do espaço, das diversas 

variáveis que compõem a superfície terrestre, enfocando múltiplos aspectos tal qual a 

necessidade do pesquisador.  

Sabendo-se que a história dos mapas é mais antiga que o próprio advento da 

escrita, compreende-se que desde as épocas remotas, os mapas exerciam grande 

importância na vida dos seres humanos. Segundo Rosa (2004), “a produção de mapas 

cresce proporcionalmente ao crescimento da população, de forma a atender seus 

interesses nos mais variados ramos de atividade”. Isso nos mostra que a ciência 

cartográfica é indispensável e está em constante aperfeiçoamento. 

No caso da Geomorfologia, que, de acordo com Guerra (1972), é a ciência que 

estuda as formas do relevo, a sua gênese, estrutura, natureza das rochas, o clima da 

região e as diferentes forças endógenas e exógenas que, de forma geral, entram como 

fatores modeladores do relevo terrestre; a cartografia geomorfológica torna-se um dos 

mais importantes meios de comunicação e análise dos resultados obtidos para essa 

ciência. As diversas análises geomorfológicas, as quais foram citadas anteriormente, 

tornam-se muito mais ricas, lógicas e melhor entendidas quando acompanhadas de 

documentos cartográficos nos quais estejam espacializadas.  

Conforme Doné (1981): 

Através de cartas são mostradas claramente os objetos e fenômenos 
estudados e suas correlações, auxiliando na ordenação do espaço, no 
grupamento dos diversos fatos geomorfológicos e na caracterização 
regional. São indispensáveis para o conhecimento científico e para as 
atividades práticas durante diversas etapas de pesquisa, exploração e 
modificação da superfície da terra pela sociedade. (p.85) 

Os mapas geomorfológicos apresentam, em contrapartida aos demais mapas 

temáticos, um grau de complexidade maior no sentido da representação dos elementos 

indispensáveis para a análise geomorfológica, uma vez que, de acordo com Ross (2007), 

apesar da comunidade de geomorfólogos apresentarem unanimidade de conteúdo geral 

para a representação nos mapas, sendo basicamente informações sobre os tipos de 

formas de relevo, gênese e idade; a maior problemática que pode ser traçada é a questão 
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da (des) padronização da representação cartográfica, visto que ainda não se chegou a um 

modelo de uniformização que atendesse os diversos interesses dos estudos 

geomorfológicos. 

Segundo Ferreira (2005), desde a década de 1960 “este assunto já era discutido 

nos encontros e comissões científicas por diversos geógrafos e geomorfólogos”. Em 

1981, Doné colocou que, apesar das várias discussões acerca da Cartografia 

Geomorfológica, ainda parecia “estar longe um método unificado internacional como 

aquele apresentado para cartas geológicas”. A mesma autora coloca a questão das 

diferenças freqüentes encontradas em mapas geomorfológicos no âmbito das 

classificações taxonômicas. Por exemplo: na Suíça, país de grande contribuição para a 

cartografia geomorfológica, por iniciativa de Annaheim, foi fundada em 1944 a 

Sociedade Geomorfológica Suíça, sendo possível para este país, montar uma legenda 

padrão. Outras concepções podem também ser citadas, como o “sistema Tricart” 

(francês), o sistema ITC (holandês) e o sistema das legendas padrão montadas na 

República Federal da Alemanha. Desta forma, ainda hoje, observa-se a falta de uma 

padronização que possa ser entendida e compartilhada no âmbito internacional.  

Também, a respeito dessa abordagem, Ferreira (2003) elabora um paralelo entre 

alguns dos sistemas da Cartografia Geomorfológica, destacando a metodologia de Ross 

e de Salome & Van Dorsser, este último que “apresenta uma comparação entre seis 

modelos de representação cartográfica do relevo de uma mesma área, mostrando e 

comparando os diferentes resultados obtidos pelas diferentes técnicas” (SOUZA, 2006). 

No Brasil, podemos citar o Projeto RADAMBRASIL, cujo objetivo foi o 

“mapeamento integrado dos recursos naturais renováveis e não renováveis do Território 

Brasileiro a partir da interpretação de imagens de radar e de outros sensores” 

(RADAMBRASIL, 1983), como também os pressupostos teóricos de Jurandyr L. S. 

Ross (1992), em cujo trabalho:   

a preocupação básica é nortear a execução de estudos técnicos de 
caráter geomorfológico engajado ao planejamento sócio-econômico e 
ambiental com a utilização de imagens de radar e satélites e o controle 
sistemático de campo. Tem como fim a geração de uma cartografia 
geomorfológica integrada de leitura direta e que subsidie o 
planejamento ambiental em espaços físico-territoriais de diferentes 
dimensões. (ROSS, 1992) 
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Além disso, podemos citar a dissertação de mestrado de Souza (2006), que se 

intitula: “Representação gráfica de feições lineares do relevo em meio digital: proposta 

de aplicação de simbologia linear na cartografia geomorfológica”. Neste estudo o autor 

coloca a questão da despadronização existente na Cartografia Geomorfológica 

enfocando os aspectos ligados aos avanços da informática e elabora simbologias que 

representam as características do relevo, na proposta de uma padronização dos 

elementos semiológicos. 

A Cartografia Geomorfológica, atualmente, têm ganhado grandes contribuições 

a partir da evolução tecnológica. As novas tecnologias, calcadas no Sensoriamento 

Remoto e Geoprocessamento, oferecem à Geomorfologia recursos imprescindíveis para 

o êxito de várias pesquisas. 

Observa-se, no entanto, que essa área não dispõe de muitos recursos didáticos 

que possibilitem um melhor aprendizado, ou seja, é praticamente escasso, documentos 

e/ou trabalhos que facilitem o aprendizado de Cartografia Geomorfológica, e ao mesmo 

tempo  em que tragam metodologias e técnicas de mapeamento voltadas para o público 

estudantil.  

Para subsidiar a elaboração do mapeamento geomorfológico neste tutorial, toma-

se como referencial metodológico os pressupostos de Jurandyr L. S. Ross (1992) que 

serão descritos a seguir. 

1.2. Proposta de cartografação geomorfológica de Jurandyr L. S. Ross (1992) 

 
A cartografação geomorfológica deve mapear concretamente o que se vê e 
não o que se deduz da análise geomorfológica, portanto em primeiro plano os 
mapas geomorfológicos devem representar os diferentes tamanhos de formas 
de relevo, dentro da escala compatível. Em primeiro plano deve-se 
representar as formas de diferentes tamanhos e em planos secundários, a 
representação da morfometria, morfogênese e morfocronologia, que têm 
vínculo direto com a tipologia das formas. (Ross, 1992:25)  

  
De acordo com a citação acima, pode-se dizer que a escala de abordagem é um 

item essencialmente importante para as análises geomorfológicas, desta forma, 

trabalhar-se-á com uma escala relativamente pequena (1: 250.000), o que garantirá a 

representação de compartimentos maiores do relevo, como as Unidades 

Morfoestruturais e as Unidades Morfoesculturais, que serão descritas em conseguinte. 
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Ross (1992) propõe a classificação taxonômica do relevo que apóia-se 

fundamentalmente no aspecto fisionômico das diferentes formas e tamanhos de relevo, 

baseado na gênese e na idade dessas formas, tendo em vista o significado morfogenético 

e as influências estruturais e esculturais no modelado. A classificação em táxons se dá 

da seguinte maneira: 

1º táxon: Unidades Morfoestruturais. É a maior forma de relevo, 
sua idade e história genética são mais antigas que as Unidades 
Morfoesculturais esculpidas em seu interior. Exemplo: Bacia Sedimentar 
do Paraná. 

2º táxon: Unidades Morfoesculturais. São de dimensões 
inferiores às das Unidades Morfoestruturais, e com idade bem menor. 
Exemplos: Planalto Paranaense, Depressão Periférica paulista. 

3º táxon: Unidades Morfológicas ou de Padrões de Formas 
Semelhantes. Estas retratam um determinado aspecto fisionômico 
decorrente das influências dos processos erosivos mais recentes e 
posteriores àqueles que esculpiram os planaltos e depressões. Exemplos: 
Padrão em morros, Padrão em colinas. 

4º táxon: Tipos de formas de relevo. Referem-se a cada uma das 
formas de relevo encontradas nas Unidades Morfológicas ou de Padrões 
de Formas Semelhantes. Exemplo: Em um Padrão em morros, cada 
morro que faz parte desse padrão possui características que o diferencia 
dos demais. 

5º táxon: Tipos de Vertentes. Representa os tipos de vertentes 
contidas em cada forma de relevo, sendo assim, de gênese e idade mais 
jovens. Exemplos: vertentes côncavas, convexas, aguçadas, etc. 

6º táxon: Formas de processos atuais. Refere-se às formas de 
relevo bem menores e muito mais recentes, que surgem ao longo das 
vertentes por processos geomórficos e até mesmo por ação antrópica. 
Exemplos: sulcos, ravinas, voçorocas. 

 
As Unidades Morfoestruturais constituem as estruturas que sustentam o relevo, o 

qual demonstra um aspecto escultural que remonta a ação do tipo climático atual e 

pretérito que atuaram/atuam na estrutura. Os aspectos esculturais constituem as 

Unidades Morfoesculturais. Sendo assim, as morfoestruturas e morfoesculturas são 

resultados da ação dinâmica dos processos endógenos e exógenos. (ROSS, 1992) 

A proposta da classificação em táxons constitui a base teórico-metodológica, 

levantada pelo autor em questão, que apresenta também em seu trabalho, os 

procedimentos técnicos e operacionais de cartografação inspirados no Projeto 

RADAMBRASIL.  
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Os conjuntos de Padrões de Formas Semelhantes foram classificados segundo 

conjuntos de letras símbolos acompanhados por um conjunto numérico. Os padrões de 

formas podem ser de Acumulação, representadas por planícies de diversas gêneses 

(planícies fluviais, planícies marinhas, etc.) e de Denudação, ou seja, esculpidas pela 

erosão, como morros, colinas, serras, entre outros. 

De acordo com Ross (1992), é possível fazer a leitura dos índices dos graus de 

entalhamento dos vales, bem como estabelecer a dimensão interfluvial média dos 

mesmos. Desta forma, Ross se inspirou nos trabalhos do RADAMBRASIL, e elaborou 

a Matriz dos Índices de Dissecação do Relevo da seguinte forma: 

Dimensão interfluvial média (classes) 
Grau de entalhamento 

dos vales (classes) 
 

Muito 
grande 

(1) 
> 3.750 

Grande 
(2) 

1.750 a 3.750 

Média 
(3) 

750 a 1.750 

Pequena 
(4) 

250 a 750 

Muito 
pequena 

(5) 
<250 

Muito fraco (1) < 20 m 11 12 13 14 15 
Fraco (2) 20 a 40 m 21 22 23 24 25 
Média (3) 40 a 80 m 31 32 33 34 35 
Forte (4) 80 a 160 m 41 42 43 44 45 

Muito forte (5) > 160 m 51 52 53 54 55 
Quadro 01: Matriz dos índices de dissecação do relevo. Fonte: ROSS, 1992. 

Assim, as identificações dos Padrões de Formas Semelhantes são extraídas da 

Matriz dos Índices de Dissecação do Relevo, sendo que, as formas Agradacionais 

(acumulação), são representadas pela letra maiúscula “A” acompanhadas de duas outras 

letras que determinam a gênese e o processo de geração da forma de agradação, por 

exemplo: Apf (Forma Agradacional de planícies fluviais), Apm (Forma Agradacional 

de planícies marinhas). Estas formas não recebem os algarismos, pois não apresentam 

dissecação por erosão.  

Já as formas Denudacionais (dissecação) são representadas pela letra “D” e 

também acompanhadas de outras duas letras que indicam o processo morfogenético 

gerador da forma, que podem ser: (a) topos aguçados, (c) convexos, (t) tabulares ou (p) 

absolutamente planos. A combinação dessas letras juntamente com os algarismos da 

Matriz (Figura 1), informa o tipo de modelado presente. Por exemplo: Da32, significa 

forma denudacional de topo aguçado com entalhamento de vale de índice 3 (20 a 40 m) 

e dimensão interfluvial de tamanho grande – 2 (700 a 1500 m). 
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Os tipos de vertentes são identificados da seguinte maneira: Ve (vertente tipo 

escarpa), Vc (tipo convexa), Vr (retilínea), Vcc (côncava), Vpp (em patamares planos), 

Vpi (em patamares inclinados), Tc (topos convexos), Tp (topos planos), entre outras.  

1.3. Tecnologias para a elaboração de documentos cartográficos  

As últimas décadas têm sido marcadas por grandes avanços tecnológicos, desde 

a invenção dos microcomputadores até a elaboração dos mais sofisticados softwares e 

hardwares que integram a gama de benefícios gerados a partir das inovações da ciência.  

Uma área que vêm se destacando é a do Sensoriamento Remoto, o qual permite 

a obtenção de informações de objetos ou alvos, sem que se tenha contato físico com os 

mesmos, envolvendo basicamente duas fases: a fase de aquisição e a fase de utilização 

de dados. Na primeira, são fornecidas informações acerca da radiação eletromagnética, 

dos sistemas sensores, do comportamento espectral dos alvos, entre outros. Na segunda 

fase, têm-se as diferentes possibilidades de utilização dos dados, tanto para a 

Geomorfologia, quanto para a Geografia como um todo e outras ciências como a 

Geologia, Pedologia, Hidrologia, Agronomia, etc. (ROSA, 2004). Desta forma, as 

técnicas de Sensoriamento Remoto propiciam de maneira rápida, precisa e segura a 

aquisição dos dados de uma dada área de interesse.  

O Geoprocessamento, termo amplo que abrange diferentes técnicas de 

tratamento e manipulação de dados geográficos a partir da utilização de programas 

computacionais, oferece como uma de suas técnicas o SIG (Sistema de Informação 

Geográfica), que “integra operações convencionais de bases de dados, com 

possibilidades de seleção e busca de informações e análise estatística, conjuntamente 

com possibilidades de visualização e análise geográfica oferecida pelos mapas” (ROSA, 

2004). Assim sendo, a utilização de SIGs têm-se intensificado no âmbito das análises 

geomorfológicas, uma vez que otimiza os trabalhos nessa esfera de conhecimento, a 

partir da premissa de que é necessário conhecer a técnica, fazer uma escolha adequada 

da legenda associada à escala cartográfica, além de uma eficaz interpretação visual dos 

fatos geomórficos e de sua gênese (SOUZA, 2006). 

Com relação aos produtos de Sensoriamento Remoto, gerados a partir de 

sensores que captam a radiação eletromagnética refletida ou emitida por alvos terrestres 

ou atmosféricos, os mesmos podem ser classificados de acordo com os tipos de 
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sensores, ativos (emissores e receptores de ondas) e passivos (apenas receptores de 

sinais). Os sensores ativos podem apresentar visada vertical e vertical/lateral em relação 

à superfície, como é o caso do RADAR, termo que significa Radio Detection and 

Ranging (detecção e medição de distâncias por ondas de rádio) (CARVALHO E 

BAYER, 2008). De acordo com Rosa (2007), o princípio básico de funcionamento de 

um radar ativo é a emissão de sinais de rádio, sendo que tais sinais são refletidos pelos 

objetos e retornam ao sensor, para o processamento do tempo decorrido entre a emissão 

e recepção. Tal sensor apresenta uma grande vantagem, pois sendo um sensor ativo tem 

a possibilidade de operar à noite, além de não depender das condições atmosféricas. 

Os produtos SRTM (Shuttle Radar Topography Mission), traduzido como 

Missão Topográfica de Radar Transportado, constituem parte do conjunto de imagens 

de Radar, sendo que apresentam sensores com visada vertical e lateral, com capacidade 

de reproduzir três dimensões espaciais do relevo: latitude, longitude e altitude (x, y, z), 

ou seja, trata-se de um modelo digital do terreno (CARVALHO e BAYER, 2008).  

Atualmente, nota-se o uso crescente dos dados matriciais de SRTM, que pode 

servir como apoio em estudos geológicos, hidrológicos, ecológicos, geomorfológicos, 

entre outros. Em particular, no caso da Geomorfologia, observa-se nessas imagens um 

bom aparato para análises quantitativas e/ou qualitativas do relevo, que, conforme 

Carvalho e Bayer (2008), são importantes especialmente na confecção de perfis 

topográficos, mapas de hipsometria e declividade, além de outros produtos relacionados 

à topografia. 

Este tipo de produto é bem operacionalizado no ArcGIS, um conjunto de 

programas que constituem um SIG, desenvolvido pela ESRI. A seguir, iremos tecer uma 

visão geral dos softwares empregados na execução deste tutorial, sendo importante 

ressaltar que o mesmo centraliza-se no programa ArcGis 9.2, no entanto, outro software 

será trabalhado para execução de funções que não se desenvolvem da maneira desejada 

neste último. Assim, podemos citar o programa ENVI 4.0 que nos auxiliará melhor em 

determinadas funções. 
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2. VISÃO GERAL DOS SOFTWARES EMPREGADOS 

2.1. Ambiente ArcGIS  

A plataforma ArcGIS baseia-se na estrutura de três aplicativos: ArcCatalog, 

ArcMap e ArcToolbox. “A utilização destas três sub-aplicações permite ao utilizador 

desempenhar qualquer tarefa simples ou complexa, incluindo a gestão de dados 

geográficos, construção de cartografia, análise espacial, edição avançada de dados ou 

ligação a base de dados externas” (TROCADO, 200-?). A versão utilizada para este 

tutorial foi o ArcGIS 9.2. 

2.1.1. ArcCatalog 

Este aplicativo permite a gestão das informações geográficas, ou seja, é um 

gerenciador de arquivos, onde se inicia muitos projetos de gestão de dados geográficos. 

O ArcCatalog é o local onde se é possível criar e manejar arquivos e pastas, possui 

funcionalidades similares ao Windows Explorer, na realização de tarefas como: 

visualizar, copiar, mover, recortar, renomear, deletar, etc., ou ainda funções espaciais 

específicas como: criar e editar metadados, visualizar o conteúdo dos dados espaciais e 

tabelas, conectar-se a servidores de dados espaciais, além da interação com os outros 

módulos. Ainda no ArcCatalog é possível fazer pesquisas para localizar os dados, 

baseadas no nome, no local ou nos metadados.  

A figura a seguir representa a janela de trabalho do ArcCatalog: 
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2.1.2. ArcMap 

O ArcMap constitui um aplicativo de visualização, análise, edição e exportação 

de mapas. É nele que será definida a informação a ser estudada e a forma de 

visualização, sendo que, neste local qualquer conjunto de dados (geográficos e/ou 

alfanuméricos) são acrescidos em formato de layer.  

O ArcMap é um conjunto de layers de informação no qual é possível executar 

um conjunto de funcionalidades. Um layer representa um conjunto homogêneo de 

entidades geográficas existente numa determinada fonte. Como exemplo podemos citar 

que numa sessão ArcMap pode existir um layer representando as unidades da federação 

de um país, outro que represente a rede de drenagem, outro representando as rodovias, 

entre outros. 

A figura a seguir representa a janela de trabalho do ArcMap: 

 

2.1.3. ArcToolbox  

O ArcToolbox é o aplicativo de geoprocessamento propriamente dito, ou seja, é 

nele que é disponibilizado acesso a todas as funcionalidades de processamento de 

dados. Ele oferece mais de 100 ferramentas para este tipo de utilização, sendo usado na 
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análise de informações georreferenciadas conforme o interesse da pesquisa. Grande 

parte das ferramentas disponíveis neste módulo propõe-se a resolver questões como 

conversão entre formatos de dados, execução de operações de análise espacial, 

operações de transformação de coordenadas entre diferentes sistemas e operações de 

construção de topologia. A figura seguinte representa o ArcToolbox com seu conjunto 

de funcionalidades: 

 

 

 

 

 

 

 

 

2.2. Ambiente ENVI 

O programa Envi apresenta uma interface gráfica de uso ("Graphical User 

Interface", GUI) que possibilita interações gráficas entre as funções e os dados com 

grande facilidade. O software possui várias ferramentas capazes de extrair diversos 

produtos das imagens da SRTM, semelhantes aos produtos também extraídos através do 

software ArcGIS, além de inúmeras funções relacionadas ao processamento de imagens. 

Para ter acesso ao manual completo do ENVI, basta acessar o link: 

<www.envi.com.br/downloads>.  

Aqui não entraremos em detalhes acerca das diversas funcionalidades do ENVI 

4.0, pois, em princípio, utilizaremos apenas uma de suas ferramentas: a geração de 

“Shaded Relief” (Relevo sombreado), que se mostrou mais adequada às nossas análises, 

do que o modelo sombreado gerado a partir do ArcGIS. A seguir serão apresentadas as 

principais janelas existentes no programa ENVI 4.0. 

Ao abrir o programa, inicialmente aparece somente o seu menu principal, a 

partir do qual o usuário tem à sua disposição toda funcionalidade do ENVI, sem ter que 
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chamar módulos a parte. Recomenda-se deixar essa barra de menu sempre visível, na 

parte superior da tela.¹ 

 

 

“O menu da janela gráfica (ou menu do display), estará disponível sempre que 

for aberta uma imagem (através do comando “Arquivo -> Abrir Imagem ...”). Ele 

encontra-se acima da imagem e é idêntico ao mostrado na figura abaixo. O menu da 

janela gráfica controla todas as funções de tela, como "linkar" imagens, examinar perfis, 

tratar imagens com aumento de contraste, produzir superposições, definir regiões de 

interesse, determinar as características das janelas de visualização e gravar as imagens 

em diferentes formatos de saída e fazer a impressão, localizar a posição de pixel, editar 

pixels (espacialmente e espectralmente), carregar dispersogramas e animações, etc.” ¹ 

 

“A janela principal mostra a imagem na resolução total (um pixel da 

imagem/corresponde a um pixel na tela), que/depende da resolução gráfica da tela e da 

placa de vídeo do computador. A moldura vermelha mostra o tamanho da janela de 

ampliação.” ¹ 

“A janela global ou Scroll Window apresenta a imagem completa em resolução 

reduzida; a moldura vermelha indica a parte da imagem correspondente à janela 
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principal. A parte da imagem visualizada em resolução verdadeira na janela principal 

pode ser selecionada clicando e arrastando a moldura vermelha na janela global, ou 

simplesmente clicando com botão esquerdo no pixel que você quer centralizar na 

imagem principal.” ¹ 

 

 

 

 

 

 

 

 

“A janela de ampliação ou Zoom window mostra a imagem ampliada. O fator de 

ampliação é mostrado no topo da janela ao lado de "Zoom"; clicar com o botão 

esquerdo nos quadradinhos vermelhos diminui “–” ou aumenta “+” o fator do zoom.” 1 

 

 

 

 

 

 

 

�������������������������������������������������������������
	 � Trechos extraídos do Guia do Envi em Português – Sulsoft Serviços de Processamento de 

Dados Ltda.�
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3. MONTAGEM DA BASE DE DADOS 

Para a confecção do mapa geomorfológico, objetivo deste tutorial, é necessária 

uma base de dados previamente estabelecida. Esta base será constituída de informações 

necessárias para a análise geomorfológica, como se segue: base geológica, para a 

construção do mapa de compartimentação morfoestrutural; base hidrográfica, referente 

à rede de drenagem; imagem SRTM, referente ao modelo digital de elevação (DEM), o 

qual nos permite obter informações em três dimensões espaciais (x, y, z). 

Primeiramente, crie um diretório específico para o armazenamento e manejo dos 

dados que serão obtidos. No menu “Iniciar”,  procure “Meu Computador”, em seguida 

“Disco Local”, que pode ser “C:” ou “D:”, entre outros, dependendo da configuração 

atual do computador do usuário. Dentro do disco local, crie uma nova pasta e nomeie-a 

como, por exemplo, “base_dados”. Criado então o diretório específico, que servirá para 

uma melhor adequação aos passos descritos nesta apostila, partiremos para a busca dos 

dados na internet.  

A figura a seguir apresenta a localização da área selecionada para este tutorial, 

mas mostra também, as diversas opções disponíveis, dentro do estado de Minas Gerais, 

caso o usuário deseje utilizar outra área para realizar os testes aqui propostos. É 

importante ressaltar que a base geológica, cujo download será descrito posteriormente, 

inicialmente será de toda a extensão do território de Minas Gerais, visto que a mesma 

não está disponibilizada na articulação de 1: 250.000.� 
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3.1. Download da base geológica 

A base geológica, juntamente com a rede de drenagem, pode ser adquirida no 

site do Serviço Geológico do Brasil – CPRM: <http://www.cprm.gov.br/>. Nesta 

página, prossiga até o link “GEOBANK”, na aba “Destaque” no lado direito da tela. Na 

sequência, o usuário será direcionado a uma nova janela, na qual, na opção 

“Downloads” deverá selecionar “Arquivos Vetoriais”. 
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Após esse procedimento, o usuário será direcionado para uma nova página, onde 

o mesmo deverá criar um cadastro e, assim, depois de fazer o login, será direcionado 

para outra página onde poderá fazer os downloads do seu interesse, sendo que, para essa 

apostila, deverão ser utilizados os arquivos referentes ao Estado de Minas Gerais.  

Na nova página, prossiga ao seguinte: “Grupos de Mapas” > “Mapas Geológicos 

Estaduais” > “Minas Gerais”. Aguarde o início do download e salve o novo arquivo no 

diretório criado anteriormente. Será necessário fazer o download, também, do mapa do 

estado de São Paulo, pois conforme se verificará posteriormente, a área selecionada para 

a aplicação do tutorial, correspondente à folha SE-23-Y-C, abrange uma pequena área 

do estado paulista (o que pode ocorrer ou não, dependendo das áreas que se desejam 

mapear). Os arquivos deverão ser salvos no diretório específico. 

 

 

 

 

 

3.2. Download SRTM 

As imagens SRTM, são facilmente encontradas no site da EMBRAPA – 

Empresa Brasileira de Pesquisas Agropecuárias, Brasil em Relevo: 

<http://www.relevobr.cnpm.embrapa.br/>. Neste site, clique no link “Dados para 

download”. 
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Em seguida, abrirá uma página de “Download do SRTM”, onde deverá ser 

selecionado o Estado referente à área de estudo. Selecione “MG”. Abrirá uma imagem 

do estado com a articulação compatível com a escala 1: 250.000, sendo que os modelos 

se encontram no Sistema de Coordenadas Geográficas e Datum WGS84. Basta clicar 

sobre uma das cartas articuladas, para que abra a página de download da mesma. Neste 

caso, selecione a Carta SE-23-Y-C. Após ter feito o download, salve o arquivo no 

diretório específico já criado. 
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4. EXECUÇÃO DE TAREFAS NOS PROGRAMAS ArcGIS 9.2 e ENVI 4.0 

4.1. Programa ArcGIS 9.2 

4.1.1. Iniciando o ArcMap (ArcGIS) 

Para iniciar o programa ArcMap, no menu “Iniciar” do computador, prossiga até 

“Todos os programas” > “ArcGIS”, e em seguida clique sobre “ArcMap”. Assim que o 

programa inicializar, será possível definir a abertura de um novo mapa (A new empty 

map) ou de um projeto já existente (An existing map). 

 

 

 

 

 

 

 

 

 

 

 

 

Iremos iniciar o novo projeto, então selecione a opção “A new empty map”. É 

necessário, neste primeiro passo, acertar as configurações das unidades de trabalho e o 

sistema de projeção cartográfica mais adequada para o tipo de trabalho que se quer 

realizar.  

Nesta apostila, a base de dados utilizada será trabalhada com o Sistema de 

Coordenadas UTM (Universal Transversa de Mercator). Esse sistema é baseado em 

coordenadas métricas, definidas para cada um dos 60 fusos divididos em 6° 

longitudinais cada um.  É importante que o usuário, quando da utilização do sistema 
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UTM, conheça a zona de localização da área de estudo e esteja ciente dos metadados 

referentes aos seus arquivos. O datum referente é o WGS 1984 para o fuso 23, que 

corresponde à área a ser mapeada.  

Na barra de menus, , clique em 

“View” > “Data Frame Properties”, em conseguinte abrirá uma nova janela, onde 

deverá ser selecionada a aba “Coordinate System” > “Select a Coordinate System” > 

“Prefefined” > “Projected Coordinate System”. 

 

 

 

 

 

 

 

 

 

 

 

Na sequência, ao mostrar os itens da opção “Projected Coordinate Systems”, 

selecione “Utm” e escolha o tipo de datum que mais se adéqua aos seus dados. Neste 

caso, deve-se selecionar “WGS 1984” > “WGS 1984 UTM Zone 23S” > “Ok”. 
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Outro passo importante necessário é a habilitação de todas as extensões do 

programa ArcMap. Para tal, na barra de ferramentas superior, em “Tools”, vá em 

“Extensions” e na nova janela habilite todas as extensões existentes. Assim feito, clique 

em “Close”. 

4.1.2. Importando arquivos 

Uma vez configurado o sistema de projeção, iremos agora, importar os arquivos 

necessários. Para isso, clique no ícone “Add Data”, , localizado na barra de 

ferramentas superior. Abrirá uma nova janela, em que o usuário deverá buscar o 

diretório que armazena seus arquivos. Conforme fora explicado anteriormente, para o 

mapeamento da Folha SE-23-Y-C é necessário a utilização dos arquivos dos estados de 

Minas Gerais e São Paulo, portanto, o usuário deverá conter dentro do diretório 

específico uma pasta para o estado de Minas Gerais e outra para São Paulo, contendo 

cada uma delas três arquivos, sendo eles, três pastas, a saber: “Litologia”, 

“Hidrografia”, “Estrutura”, além da imagem no formato TIF, referente à SRTM, com o 

nome de “SE-23-Y-C”. 

  

 

 

 

 

Inicialmente, trabalharemos com a confecção do mapa morfoestrutural, 

correspondente ao 1º táxon na classificação de Ross (1992). Desta forma, no diretório 

“Minas Gerais” importe o arquivo vetorial existente dentro da pasta “Litologia”, o qual 

se chama “minas_lito.shp”. Faça o mesmo com os arquivos vetoriais da pasta 

“Hidrografia” (são dois, um referente à rede de drenagem e outro à represa, sendo o 

primeiro em formato de linha e o segundo em polígono). Assim também deverá ser feito 

para os arquivos referentes ao estado de São Paulo e também com a imagem “SE-23-Y-

C”. 
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Caso a imagem da SRTM apareça escura na vista do “ArcMap”, é preciso 

configurá-la. Assim, com o botão direito do mouse clique sobre a imagem na guia 

“Layers”, vá em “Properties” > “Simbology” > “Stretch” > “Type” > “Minimum-

Maximum” > “Ok”. 

Salve o seu projeto no ícone “Save” , no diretório específico já criado, 

pode-se nomeá-lo como “Meu_projeto”. 

Após a importação dos dados, iremos recortar a área de estudo, delimitada pela 

folha SE-23-Y-C nos demais arquivos que integram todo o estado de Minas Gerais e 

São Paulo. Para isso utilizaremos o “ArcTollbox”, representado pelo ícone , 

também localizado na barra de ferramentas superior. Este aplicativo, conforme já foi 

descrito anteriormente, é de grande importância e deverá permanecer ativo, para 

posteriores usos. Antes disso, é necessário criar um polígono sobre os limites da 

imagem “SE-23-Y-C”. 

4.1.3. Criando polígonos 

Com o botão direito do mouse clique sobre a barra de ferramentas, aparecerá 

uma guia com diversas opções, entre as quais deverão ser selecionadas “Editor” e “3D 

Analyst”. Arraste as novas guias abertas até a barra de ferramentas já existente, até que 

as mesmas se compactem junto às outras.  
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É necessário criar um arquivo “shapefile” no “ArcCatalog”, para iniciar a sua 

edição com os limites da imagem que se deseja. Abra o “ArcCatalog”  e neste, 

procure o diretório específico para a armazenagem dos seus dados. Clique com o botão 

direiro do mouse, “New” > “Shapefile” e na nova janela, dê um nome para o novo 

Shape, como por exemplo, “recorte”, e em “Feature Type” selecione a opção “Polygon” 

e marque as opções “Coordinates will contain M values. Used to store route data.” e 

“Coordinates will contain Z values. Used to store 3D data.”. É importante selecionar o 

sistema de coordenadas do novo shape, portanto, vá em “Edit” e na nova janela “ 

Select” > “Projected Coordinate Systems” > “Utm” > “WGS 1984” > “WGS 1984 

UTM Zone 23S” > “Add” > “Ok”. Feche o “ArcCatalog”. 

 

 

 

 

 

 

 

 

De volta ao “ArcMap”, na opção “Add Data”, importe o shape “recorte”, criado 

anteriormente. Na barra de ferramentas, em “Editor” selecione “Start Editing”, e na 

nova janela, procure o arquivo a ser editado, no caso “recorte” > “Ok”.  
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Na guia “Layers”, desmarque todos os arquivos, com exceção do “recorte” e do 

“SE-23-Y-C”. Na barra “Editor”, em “Task” selecione “Create a new feature” e no 

ícone “Sketch Toll” , selecione o lápis. Agora, desenhe o polígono sobre os 

limites da imagem SRTM, que deverá ter o formato de um retângulo, desta forma, para 

iniciar a edição basta clicar uma vez, em seguida clicar em cada vértice necessário e 

para finalizar o polígono, dê um duplo clique. Terminado o processo, prossiga até 

“Editor” > “Stop Editing” e salve sua edição.  

O polígono deverá ter essa aparência: 

 

 

 

 

Fique sabendo: Para modificar informações de polígonos em sua tabela de atributos, 

prossiga até a barra “Editor” > ícone “Attributes”� , aparecerá uma pequena janela, 

onde é possível modificar a informação dos atributos. (Pode ser aplicado em outros 

casos, neste não é necessário). 

 

 

 

Para editar o retângulo criado, como modificar a cor, o tipo de preenchimento, 

etc., deve-se clicar com o botão direito sobre o “recorte” > “Properties” > “Simbology” 

e escolher na opção “Features” > “Single symbol” > “Symbol” as cores e o 

preenchimento desejáveis. Neste caso, pode-se escolher a opção sem preenchimento 

(Hollow) com a cor da linha preta. 
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4.1.4. Utilizando a ferramenta “Clip” (Recortar) 

A ferramenta “Clip” será utilizada para reduzir os arquivos inteiros (Litologia, 

Hidrografia) para o tamanho da área de interesse, referente à carta na escala 1: 250.000. 

Na guia do “ArcToolbox”, selecione “Analysis Tools” > “Extract” > “Clip”, 

abrirá uma nova janela em que o usuário deverá selecionar o arquivo de entrada e o de 

execução do “Clip”. O de entrada será o arquivo que se deseja recortar e o de “Clip” 

será o arquivo que norteará o recorte. Desta forma, na opção “Input features”, clique na 

setinha à direita, onde aparecerá os arquivos vetoriais existentes, e escolha, sem uma 

ordem especial, por exemplo, “minas_lito”. Em “Clip Features” selecione “recorte”, o 

polígono editado anteriormente e que corresponde à área de interesse. Em “Output 

Feature Class” selecione um local no ícone  para salvar o novo “Clip” e nomeie-o 

como “rec_lito”. Clique em “Ok”, assim, abrirá uma nova janela, então aguarde o 

procedimento concluir e clique em “Close”.  
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A imagem resultante terá esta aparência, observe que na parte baixa da imagem 

falta informação, que será preenchida com o recorte dos arquivos do estado de São 

Paulo. 

 

 

 

 

 

 

Faça o mesmo procedimento para os arquivos “minas_unifilar” e 

“minas_bifilar”, renomeando os resultados, respectivamente, como “rec_hidro” e 

“rec_represa”. Assim também deve ser feito com os arquivos referentes ao estado de 

São Paulo para preencher a parte vazia que ficou no recorte das informações de Minas 

Gerais, a saber: “sp_lito” e “sp_ unifilar” que deverão ser renomeados, respectivamente, 

“rec_sp_lito” e “rec_sp_hidro”. Os novos shapes serão inseridos automaticamente na 

guia “Layers”, desta forma, não precisa-se mais dos outros arquivos inteiros 

(“minas_lito”, “minas_unifilar”, “minas_bifilar”, “sp_lito” e “sp_unifilar”), podendo os 

mesmos serem removidos através da opção: botão direito do mouse > “Remove”.  

Obs.: Não se esqueça de sempre salvar o projeto. 

Os novos arquivos podem ser editados quanto à cor, tipo de informação que 

aparece, etc. Para mudar as cores da hidrografia, siga o mesmo procedimento mostrado 

para editar o polígono “recorte”. Já no caso do arquivo “rec_lito”, o mesmo apresenta 

diversas informações, entre as quais podemos selecionar as de interesse. Essas 

informações podem ser averiguadas na tabela de atributos, clicando com o botão direito 

do mouse sobre “rec_lito” > “Open Attribute table”. Nesta tabela é possível visualizar 

todas as informações disponíveis da área que abrange o arquivo. As informações que 

deverão ser consideradas serão explicadas no tópico seguinte. 
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4.1.5. Delineando as Unidades Morfoestruturais 

Conforme já foi descrito, as Unidades Morfoestruturais constituem as estruturas 

que sustentam o relevo, daí sua grande importância para a Geomorfologia. Para 

construir o mapa de compartimentação morfoestrutural, o usuário deve possuir 

conhecimento prévio e acumulado acerca dos aspectos referentes à Geologia e conhecer 

os elementos/unidades e a idade que formam uma grande estrutura para proceder às 

análises morfoestruturais. Para este tutorial, tais procedimentos foram previamente 

realizados, portanto, encontram-se aqui os resultados das análises feitas e o passo-a-

passo para o desenho da compartimentação morfoestrutural.  

Para o delineamento das Unidades Morfoestruturais, tomaremos como referência 

os padrões de idade (Eon) e tipo das rochas. Para tal, na guia “Layers”, clique com o 

botão direito do mouse sobre o layer “rec_lito”, vá em “Properties”, e na nova janela, 

em “Simbology” > “Categories” > “Unique values, many fields” > “Value fields” 

selecione na primeira opção “EON_IDAD_M” e na segunda opção selecione 

“CLASSE_ROC”, conforme o grau de aprofundamento que se deseja obter, pode-se 

levar em consideração, como um terceiro parâmetro, a Era geológica de determinado 

conjunto litológico, neste caso, a opção “ERA_MAXIMA”. Posteriormente, clique em 

“Add all values” e dê “ok”. A coloração pode ser modificada na paleta “Color Ramp”. 

E, neste caso, o mesmo procedimento deverá ser feito com o shape “rec_sp_lito”.  
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O shape aparecerá na vista do ArcMap classificado de acordo com a idade e o 

tipo de rocha. Pode ocorrer, em alguns casos, que as informações estejam faltando, o 

que pode ser solucionado bastando apenas que o usuário consulte a tabela de atributos 

para verificar o restante das informações referentes àquele shape ou utilizar o ícone , 

clicando sobre as feições desejadas. Após termos desdobrado as informações de idade e 

tipos de rochas, será necessário utilizar a ferramenta “Dissolve” que extrai e unifica as 

informações semelhantes em um novo shapefile. 

Para tal, é necessário: na guia do ArcToolbox, clicar em “Data Management 

Tools” > “Generalization” > “Dissolve”. Assim abrirá uma janela, na qual em “Input 

features” deverá ser selecionado o shape “rec_lito”. Logo abaixo, em “Output Feature 

Class” deve-se selecionar um local para salvar o novo arquivo “Dissolve” e renomeá-lo 

se desejar. Em Dissolve_Field(s) deve-se selecionar os atributos especificados acima: 

“EON_IDAD_M” e “CLASSE_ROC”, clicar em “Ok” e aguardar o processamento.  
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Agora, no novo shape, clique com o botão direito do mouse e selecione “Open 

Attribute Table”. Na tabela de atributos insira uma nova coluna através da opção 

“Options” > “Add Field”. Na nova janela, em “Name” deve-se nomear a coluna, neste 

caso “Morfoestru”, em “Type” selecione “Text” e clique em “Ok”. Pronto, a nova 

coluna será adicionada. 

 

 

 

 

 

 

Feito isso, será necessário inserir a nomenclatura das Unidades Morfoestruturais 

à coluna criada na tabela de atributos. Para tal, na barra de ferramentas, clique em 

“Editor” > “Start Editing” e na nova janela selecione o caminho do arquivo de interesse 

e dê “ok”. Assim, o comando de edição estará aberto sendo possível inserir os nomes na 

�
��
����� �
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tabela de atributos. Novamente, sobre o layer em edição clique com o botão direito do 

mouse e abra “Open Attribute Table”, a partir disso, basta editar na coluna 

“Morfoestru” os nomes de cada Unidade Morfoestrutural de acordo com as análises 

previamente realizadas acerca da idade e o tipo de rocha. 

Assim feito, em “Editor” clique em “Stop Editing” e salve suas edições.  

Para visualizar a compartimentação morfoestrutural, na janela de propriedades 

do layer específico, em “Simbology” > “Categories” > “Unique values” > “Value 

fields” selecione “Morfoestru”. Clique em “Add all values” e dê “ok”. 

Pode ocorrer que as Unidades Morfoestruturais se dividam em vários polígonos, 

o que pode dificultar os procedimentos que serão descritos no item 15, portanto, para 

resolver essa questão, utiliza-se a ferramenta “Dissolve” já descrita, inserindo em 

“Dissolve_Field” o atributo “Morfoestru”. Assim, o novo arquivo apresentará a 

generalização dos polígonos referentes à mesma unidade. 

No caso da Folha SE-23-Y-C, foi possível identificar cinco Unidades 

Morfoestruturais, sendo elas: Bacia Sedimentar do Paraná, Bacia Sedimentar 

Cenozóica, Bacia Sedimentar do São Francisco, Faixa de Dobramentos e Intrusões 

Dômicas/Ígneas. 

O novo arquivo aparecerá automaticamente na guia “Layers” e deverá ter essa 

aparência: 
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4.1.6. Criando o TIN 

A ferramenta “Triangular Irregular Network”, mais conhecida como TIN, é uma 

estrutura de grade triangular do tipo vetorial, apresenta topologia do tipo nó-arco que 

possibilita a representação de uma superfície através de um conjunto de faces 

triangulares interligadas. Cada um dos três vértices da face triangular armazena 

informações sobre a localização (x, y) e sobre os valores de altitude/elevação 

correspondente ao eixo z (COELHO, 2007). 

Para criar o TIN, precisaremos exatamente da imagem SRTM (SE-23-Y-C), a 

partir da qual, extrairemos as curvas de nível. Na barra de ferramentas, em “3D 

analyst”, prossiga até “Surface Analysis” > “Contour”. Na nova janela, em “Input 

surface” selecione SE-23-Y-C, na opção “Contour interval” escolha o intervalo entre as 

curvas, neste caso, colocamos o intervalo de 50 metros, devido ao tamanho da área de 

interesse. Em “Output features” selecione o local para salvar as curvas e nomeie-as, por 

exemplo, “curvas_nível”, dê “Ok” e aguarde o processamento. 
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O arquivo será adicionado à paleta “Layers” automaticamente e terá essa 

aparência: 

  

 

 

 

 

 

 

 

 

 

Para prosseguir, com as curvas já geradas, clique em “3D analyst” > “Create 

Modify TIN” > “Create TIN From Features”. Na nova janela, em “Layers”, marque a 

opção “curvas_nível” e em “Output TIN” selecione um local para salvar o TIN a ser 

criado, “Ok”. Aguarde o processamento. 
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A imagem criada terá essas feições: 

 

 

 

 

 

 

 

 

Como todos os outros arquivos, o “tin” também poderá ser editado. Clique com 

o botão direito do mouse sobre “tin” e selecione “Properties”. Na nova janela, abra a aba 

“Simbology”, desmarque a opção “Edge types” e remova-a (“Remove”). Na opção 

“Add”, é possível adicionar diferentes feições além da elevação (elevation), tais como a 

declividade (slope), o aspecto das vertentes (aspect), entre outros. Inicialmente, 

trataremos da elevação e declividade. Em “Add”, selecione a opção “Face slope with 

graduated color ramp” > “Add” e para fechar a janela “Add renderer” clique em 

“Dismiss”. 
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4.1.7. Trabalhando a elevação (elevation) 

Para a confecção do mapa hipsométrico (elevation), deve-se estabelecer 

primeiramente as classes de altimetria que mais se adéquam à área a ser mapeada. Na 

janela “Layer Properties”, deixe selecionada a opção “Elevation”. No quadrante 

“Classification” é possível estabelecer as classes altimétricas, sendo que, em “Classes” 

define-se o número das classes e em “Classify” o intervalo entre elas. Para o nosso caso, 

o número de classes será nove. A definição dos intervalos pode ser determinada de 100 

em 100 metros.  
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Prossiga até “Classify”, abrirá uma nova janela, vá até a guia “Classification” > 

“Method” > “Manual”. Observe na guia “Classification Statistics”, o menor e o maior 

valor altimétrico, respectivamente, 500 e 1350. Desta forma, na guia “Break Values”, 

redigite as classes de 100 em 100 metros, podem-se definir as seguintes classes: 550 – 

650 – 750 – 850 – 950 -1050 – 1150 – 1250 – 1350. Assim feito, clique em “Ok”. 

Recomenda-se fazer tal procedimento de baixo para cima, na ordem decrescente. 
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Ao retornar para a janela anterior, pode-se mudar as cores do mapa na opção 

“Color Ramp”, considerando, como um melhor parâmetro, cores mais fortes para as 

maiores altitudes e cores mais fracas para as menores. Ao clicar com o botão direito do 

mouse sobre as classes já estabelecidas, a opção “Flip Symbols” inverte a ordem das 

cores. Clique em “Ok”. 

 

 

 

 

 

 

 

 

 

 

O mapa hipsométrico resultante terá essa aparência: 
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4.1.8. Trabalhando a declividade (slope) 

O mapa de declividade tem o objetivo de demonstrar as inclinações de uma área 

em relação a um eixo horizontal. Serve como fonte de informações das formas do 

relevo, das aptidões agrícolas, riscos de erosão, restrições de uso e ocupação urbana, 

entre outros.  

Para a construção do mapa de declividade, é preciso estabelecer as classes de 

declive predominantes na área de interesse. O procedimento de classificação da 

declividade assemelha-se ao de hipsometria, pois são realizados na mesma janela de 

trabalho. Na guia “Layers”, clique com o botão direito sobre “tin” > “Properties”, e na 

nova janela, abra a aba “Simbology”, selecione a opção “Slope”. Iremos aqui definir as 

classes de declividade em cinco: “Classes” > 5 . Para classificar os intervalos, clique em 

“Classify”.  

 

 

 

 

 

 

 

 

 

 

Na nova janela aberta, prossiga até “Classification” > “Method” e selecione a 

opção “Manual”. Na guia “Break Values” edite os intervalos de classe. Aqui, 

selecionamos os intervalos de 0 – 2, 3 – 5, 6 – 12, 13 – 20, 20 – 50. Esta opção tornou-

se viável com a observação do gráfico que estabelece a frequência dos graus de 

declividade, que se apresenta na forma de porcentagem. Em “Classification Statistics” 

são apresentados os valores mínimo e máximo de declividade encontrados na imagem, 
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no entanto, os valores existentes apresentam erros gerados pelo próprio recorte/formato 

da imagem SRTM, não podendo ser levados em consideração, daí a importância da 

análise do gráfico de frequência. Após estabelecer as classes, clique em “Ok”.  

 

 

 

 

 

 

 

 

Ao retornar para a janela anterior, conforme já fora descrito no item antecedente, 

pode-se alterar a coloração do mapa na opção “Color Ramp”, no caso da declividade, 

considera-se como um melhor parâmetro, cores em degradê, mais fortes para as maiores 

declividades e mais fracas para as menores. Para inverter a ordem das cores, clique com 

o botão direito do mouse sobre as classes, e selecione a opção “Flip Symbols”. Além 

disso, pode-se alterar a quantidade de números depois da vírgula nas classes de 

declividade. Também clicando com o botão direito selecione a opção “Format Label” > 

“Numeric” < “Number of decimal places” e escolha zero, “Ok”. Em “Layer properties”, 

“Ok” novamente. 
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O mapa de declividade resultante terá essa aparência: 

 

 

 

 

 

 

 

 

 

 

Obs: Até aqui, geramos o mapa de compartimentação morfoestrutural, as curvas de 

nível e a grade triangular (TIN), editando a hipsometria e a declividade. Agora, 

partiremos para o programa ENVI 4.0, para gerar o “Shaded Relief” (modelo 

sombreado) e logo em seguida retornaremos ao ArcGIS para executarmos a 

compartimentação morfoescultural, referente ao 2º táxon na concepção de Ross (1992). 
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4.2.  Programa ENVI 4.0 

4.2.1. Iniciando o ENVI 4.0 

Obs.: Antes de iniciar o programa Envi 4.0 é necessário sair do programa 

ArcGis. 

Para iniciar o programa Envi, no menu “Iniciar” do computador,  prossiga até 

“Todos os programas” > “RSI ENVI 4.0” > “ENVI”. Assim que o programa inicializar, 

iremos importar a imagem da SRTM correspondente à área de estudo, cujo formato é 

Geo TIFF. Para tal, deve-se: (1) clicar em “File” > “Open External File” > “Generic 

Formats” > “TIFF/Geo TIFF”. Assim, devemos escolher a imagem SE-23-Y-C. Abrirá 

uma nova janela intitulada (2) “Available Bands List”, na qual deve-se selecionar as 

bandas da imagem para que ela apareça na tela. Neste caso, a imagem da SRTM 

apresenta apenas uma banda que deve ser selecionada: “ Band 1”, em seguida deve-se 

escolher a opção “Gray Scale” (escala de cinza) e “Load Band”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 
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Após esse procedimento, a imagem aparecerá em três janelas, que já foram 

especificadas anteriormente.  

4.2.2. Gerando a imagem “Shaded Relief” 

Faremos agora a geração do “Shaded Relief” através dos seguintes passos: no 

menu principal do ENVI, prossiga até “Topographic” > “Topographic Modeling”, 

abrirá uma nova janela, na qual, deve-se selecionar a “Band 1” para que as informações 

da imagem apareçam na guia “Band Information”, clicar em “Ok”. 

 

 

 

 

 

 

2 
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Logo em seguida uma nova janela será aberta, na qual, na guia “Select 

Topographic Measures to Comput” deve ser selecionada a opção “Shaded Relief”. 

Abaixo, na guia “Comput Sun Elevation and Azimuth”, digite o valor 30 para 

“Elevation” e 45 para “Azimuth” (esses valores foram selecionados por se adequarem 

ao resultado almejado). Na opção “Enter Output File Name” clique em “Choose” e 

escolha um local e um nome para salvar o novo arquivo. Pode-se nomeá-lo como 

“Img_sombreada”. Aguarde o processamento, sendo que, a nova imagem aparecerá na 

janela “Available Bands List”, selecione “Shaded Relief (Band 1: SE-23-Y-C.tif)” > “ 

“Gray Scale” > “Load Band”. 
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A imagem sombreada substituirá a anterior na tela e deverá ter essa aparência na 

janela principal: 

 

 

 

 

 

 

 

Com a imagem em visualização, iremos agora exportá-la para que seja possível a 

sua interpretação no ArcGIS. Assim sendo, no menu da janela principal, clique em 

“File” > “Save Image As” > “Image File”. Abrirá uma nova janela, na qual, em “Output 

File Type” deve-se selecionar o tipo de arquivo que se deseja exportar, neste caso, 

selecione “TIFF/Geo TIFF”. Na opção “Enter Output Filename” escolha o local de 

salvamento do novo arquivo e nomeie-o, como por exemplo, “Img_sombr”, clique em 

“Ok”. 

 

 

 

 

 

 

 

 

 

Após esse procedimento, termina a nossa seção no Envi, feche então o programa 

e volte ao ArcGIS. 
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5. CRIAÇÃO DAS UNIDADES MORFOESCULTURAIS (ArcGIS) 

5.1. Classificação por Máxima Verossimilhança 

O primeiro passo para o delineamento das unidades morfoesculturais constitui-se 

por meio da classificação automática por máxima verossimilhança da imagem da SRTM 

(SE-23-Y-C). Para tal, prossiga ao ArcToolbox e em “Spatial Analyst Tools” selecione 

“Multivariate” > “Create Signature”, abrirá uma nova janela, na qual, em “Input raster 

bands” selecione a imagem da SRTM (SE-23-Y-C); em “Input raster or feature sample 

data” selecione o arquivo shape “curvas_nível”. A opção “Output signature file” mostra 

o nome do novo arquivo a ser criado e o seu local de salvamento (Formato *GSG), 

recomenda-se não alterar essa informação, mas guardá-la para posterior uso. Clique em 

“Ok” e aguarde o processamento. 

 

 

 

 

 

 

 

 

 

Logo em seguida, volte à “Spatial Analyst Tools” > “Multivariate” e selecione 

“Maximum Likelihood Classification”, na nova janela, em “Input raster bands” deve se 

colocar a imagem da SRTM (SE-23-Y-C). Em “Input signature file” deve-se buscar o 

arquivo *GSG gerado no procedimento anterior, em “Output classified raster” selecione 

o local e o nome para o salvamento do arquivo. Clique em “Ok” e aguarde o 

processamento. 
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O novo Raster criado será automaticamente adicionado à guia “Layers” e deverá 

ser semelhante a este: 

 

 

 

 

 

 

 

 

 

 

No próximo passo iremos separar as Unidades Morfoestruturais, pois desta 

forma se tornarão mais fáceis as nossas análises para o delineamento das Unidades 

Morfoesculturais de cada compartimento estrutural. Esse procedimento também será 

realizado posteriormente com a imagem classificada neste item, a imagem da SRTM e a 

imagem sombreada (Shaded Relief). 
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5.2. Separando as Unidades Morfoestruturais  

Na guia “Layers” deixe selecionado apenas o shape referente às Unidades 

Morfoestruturais (que nomeamos “Unid_Morfoestrutural”). Assim sendo, selecione na 

barra de ferramentas o ícone “Select Features”  para selecionar cada feição no 

shape existente. Sem uma ordem especial, clique sobre uma das feições (como por 

exemplo, a Unidade Morfoestrutural Bacia Sedimentar do Paraná). Depois, volte à guia 

“Layers” e clique com o botão direito do mouse sobre o shape “Unid_Morfoestrutural” 

> “Selection” > “Create Layer From Selected Features”. Assim, a feição selecionada 

será adicionada à guia de “Layers”, possibilitando a criação de um novo shape da 

Unidade individualizada. Para tal, é preciso, na guia do ArcToolbox, clicar em 

“Conversion Tools” > “To Shapefile” > “Feature Class to Shapefile (Multiple)”. Abrirá 

uma nova janela, na qual, em “Input Features” deve ser selecionada a Unidade 

individualizada e em “Output Folder” deverá ser escolhido o local de salvamento. Fazer 

assim para cada Unidade Morfoestrutural, sendo que ao final teremos cinco novos 

shapes na guia “Layers”, referentes a todas as Unidades Morfoestruturais encontradas 

na área de estudo.  

Após esse procedimento, para facilitar o seu manejo, pode-se renomear os novos 

shapes criados ao clicar duas vezes pausadas sobre o nome atual na guia “Layers”. 

Podem assim ficar: Bacia Sedimentar do Paraná, Faixa de Dobramentos, Bacia 

Sedimentar do São Francisco, Bacia Sedimentar Cenozóica, Intrusões Dômicas/Ígneas. 

 

 

 

 

 

 

 



��������������
Manuais Técnicos – Rev. Geogr. Acadêmica, v.3, n.2 (xii.2009)                               ISSN 1678-7226                                    
Thallita Isabela Silva, Sílvio Carlos Rodrigues_______________________________________ �

�

���

 

 

 

 

 

 

5.3. Separando por Unidades Morfoestruturais a Imagem Classificada, a 

Imagem da SRTM e a Imagem Sombreada 

O procedimento de recorte de imagens Raster ocorre da seguinte maneira: na 

guia do ArcToolbox , clique em “Spatial Analyst Tools” > “Extraction” > “Extract by 

Mask”. Na nova janela, em “Input Raster” coloque a imagem inteira desejada, em 

“Input Raster or Feature” coloque a feição que se deseja extrair (no caso, as Unidades 

Morfoestruturais individualizadas), e em “Output raster” dê um nome para o novo 

arquivo. Primeiramente, recortaremos a imagem classificada, assim, deveremos obter 

cinco produtos, os quais deverão ser nomeados sempre com referência à imagem “mãe”, 

por exemplo: “Bac_Par_class”, “Bac_Fran_class” e assim por diante. A imagem da 

SRTM também deverá ser recortada, resultando também em cinco produtos e nomeados 

da mesma maneira, por exemplo, “Bac_Par_srtm”, “Bac_Franc_srtm”, etc. 

Em seguida, deve-se extrair a imagem sombreada gerada pelo programa ENVI, 

para tal, inicialmente, deve-se adicioná-la à guia de “Layers” através do ícone . 

Feito isso, basta seguir o procedimento anterior e da mesma forma que as imagens 

classificada e SRTM, deve-se obter cinco produtos para a imagem sombreada, 

nomeando-os com referência à imagem “mãe”, como por exemplo, “Bac_Par_sombr”, 

“Bac_Fran_sombr”, etc. 
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Desta forma, teremos três arquivos Raster (um referente à imagem classificada, 

outro à imagem da SRTM e outro à imagem sombreada) para cada Unidade 

Morfoestrutural. 

5.4. Analisando cada Unidade Morfoestrutural 

Já com as imagens individualizadas de cada morfoestrutura, partiremos para a 

identificação das formas esculturais, que segundo Ross (1992) são geradas pela ação 

climática no decorrer do tempo geológico e possuem dimensões e idade inferiores às 

das Unidades Morfoestruturais. Para a identificação das morfoesculturas, tomaremos 

como referência a diferenciação de sombra e rugosidade representadas pela imagem 

sombreada, correlacionando-a com os diferentes patamares altimétricos, ou seja, a partir 

das curvas de nível. Este procedimento requer a interpretação visual do “mapeador”, 

sendo que algumas feições estruturais por si mesmas já constituem unidades esculturais, 

como por exemplo, as Intrusões Dômicas/Ígneas. Outra forma de identificação das 

morfoesculturas é com o auxílio de perfis topográficos, importantes por representar um 

corte transversal da superfície demonstrando os diferentes padrões altimétricos ao cortar 

várias unidades de relevo. 

No tópico a seguir serão apresentados os procedimentos para a construção dos 

diferentes compartimentos morfoesculturais da Bacia Sedimentar do Paraná, sendo que, 

os procedimentos para as demais Unidades Morfoestruturais se assemelham à primeira, 

sendo, portanto, desnecessária a sua repetição em todos os tópicos. Porém, serão 

demonstrados os resultados encontrados para cada unidade. 

5.4.1. Unidade Morfoestrutural Bacia Sedimentar do Paraná 

Para trabalhar com a Unidade Morfoestrutural Bacia Sedimentar do Paraná, é 

necessário ativar na guia de “Layers” os arquivos referentes à mesma, neste caso, a 

imagem classificada (“Bac_Par_class”), a imagem da SRTM (“Bac_Par_srtm), a 

imagem sombreada (“Bac_Par_sombr”) e as curvas de nível geradas no item 13 (as 

curvas não foram recortadas para cada morfoestrutura, pois não julgou-se necessário). 

Feito isso, sobreponha as curvas de nível à imagem sombreada, assim, 

identifique as diferenciações de sombra e rugosidade e associe-as com as curvas de 

nível que possam limitar essas diferenciações.  
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O ícone “Identify”  permite a visualização dos atributos de determinado 

shape, desta forma, ao ser selecionado clique sobre a feição desejada e aparecerá uma 

janela com os seus atributos, faça isso para verificar as curvas de nível. A partir dessa 

interpretação, deve-se ficar claro o número de classes que existem dentro da 

morfoestrutura (Obs.: anotar as observações em um bloco de notas facilita o trabalho de 

correlação). É importante ressaltar que a interpretação pode exigir um tempo maior de 

execução. 

 

 

 

 

 

 

 

 

 

 

 

Observando as figuras acima é possível identificar três classes altimétricas que 

diferenciam sombra e rugosidade. Sendo elas, 1: > 900 m, 2: 750 – 900 m e 3: < 750 m. 

Este resultado é possível de ser verificado, também, por meio de perfis 

topográficos. Estes últimos são gerados a partir da imagem da SRTM por meio do ícone 

“Interpolate Line” . Ao selecionar este ícone, deve-se, primeiramente, escolher na 

opção “Layer” da barra de ferramentas, a imagem da SRTM, da qual deseja-se extrair o 

perfil topográfico. Após isso, deve-se clicar sobre a imagem da SRTM no ponto em que 

desejar iniciar o perfil a ser criado e, para finalizar, basta dar um clique duplo. Assim 

1 
1 

2 

2 

3 

1 
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feito, selecione o ícone “Create Profile Graph” , que gera automaticamente o 

gráfico do perfil. Pode-se criar quantos perfis forem necessários. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Deste modo, com três classes definidas, deve-se fazer uma reclassificação 

supervisionada a partir da imagem classificada. Para tal, prossiga até “3D Analyst 

Tools”, em “Raster Reclass” selecione “Reclassify”. 

Ponto  
inicial  

Ponto 
 final 

Compartimento 
1 

< 700 m 

Compartimento 
2 

700 - 900 m 

�

Compartimento 
3 

> 900 m 

�
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Assim, abrirá uma nova janela intitulada “Reclassify”, na qual, em “Input 

Raster” deve-se selecionar a imagem classificada referente à Bacia Sedimentar do 

Paraná (“Bac_Par_class”). Em “Reclass field” deve-se deixar selecionada a opção 

“VALUE”. Na seção “Reclassification”, primeiramente, deve-se clicar em “Classify”, 

que abrirá uma nova janela, na qual deve-se proceder desta forma: em “Classification” 

> “Method”, selecione “Equal Interval”, depois, em “Classes”, escolha o número 3 

(referente às classes identificadas anteriormente). Volte à “Method” e selecione 

“Manual”. Após isso, em “Break Values”, digite os valores das classes altimétricas 

escolhidas anteriormente (deve ser digitado o valor final de cada classe). Clique em 

“Ok”. 

O próximo passo, ainda na janela “Reclassify”, é a edição dos novos valores na 

coluna “New values” da seção “Reclassification”. Da mesma forma como no passo 

anterior, devem ser digitados os valores finais de cada classe, conforme especificado na 

figura a seguir. Em “Output raster” selecione o nome e o local de salvamento do novo 

arquivo. Clique em “Ok” e aguarde o processamento. 
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A imagem gerada deverá ser semelhante a esta: 
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O próximo passo é transformar essa imagem Raster em shapefile para que 

possamos editar os polígonos e acrescentar informações a eles. Para tal, na guia do 

ArcToolbox prossiga até “Conversion Tools” > “From Raster” > “Raster to Polygon”. 

Na nova janela, em “Input Raster” selecione a imagem (re) classificada anteriormente, 

em “Field” escolha “VALUE” e em “Output polygon features” escolha o local e um 

nome para o salvamento do novo arquivo shape. Clique em “Ok” e aguarde o 

processamento. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Com o arquivo shape criado, pode-se observar que a imagem apresenta vários 

polígonos, sendo que, alguns representam a mesma unidade morfoescultural e outros, 

apesar de estarem na mesma classe altimétrica fazem parte de unidades diferentes. 

Obs.: É importante ressaltar que, apesar da classificação ter sido feita com base em três 

classes altimétricas, os compartimentos existentes podem ultrapassar este número, como 
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é o caso da Bacia Sedimentar do Paraná. Deve-se levar também em consideração, na 

identificação dos diferentes compartimentos, a localização, os fatores condicionantes, 

entre outros. 

Para editar os polígonos lhes conferindo informações distintas é necessário, 

primeiramente, inserir uma nova coluna na tabela de atributos do shapefile em questão. 

Para tal, na guia de “Layers” clique com o botão direito do mouse sobre o arquivo 

shape, selecione “Open Attribute Table” > “Options” > “Add Field”. Na nova janela, 

em “Name” deve-se nomear a coluna, neste caso “Morfoescul”, em “Type” selecione 

“Text” e clique em “Ok”. Pronto, a nova coluna será adicionada.  

 

 

 

 

 

 

Anteriormente ao início da edição, deve-se possuir esquematizada, a 

nomenclatura dos diferentes compartimentos morfoesculturais. Para este tutorial, foram 

definidos os compartimentos esculturais da seguinte maneira: a) a área correspondente à 

classe altimétrica < 750 m foi dividida em duas unidades morfoesculturais: ao norte, 

percorrendo o vale do Rio Araguari, foi definida Unidade Morfoescultural Canyon do 

Rio Araguari, e a maior parte ao sul, foi nomeada Unidade Morfoescultural Planalto do 

Rio Grande; b) a área correspondente à classe altimétrica 750 – 900 m também foi 

dividida em duas unidades: ao norte, a área que percorre o vale do Rio Araguari, foi 

definida também como Unidade Morfoescultural Canyon do Rio Araguari e, ao sul, 

como Unidade Morfoescultural Planalto Dissecado; c) a área correspondente à classe 

altimétrica > 900 m foi definida como Unidade Morfoescultural Planalto Tabular. Essa 

classificação levou em consideração os atributos morfométricos, relacionados aos 

valores topográficos, e os atributos morfológicos, relacionados à geometria/tipologia 

das formas. 
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Na sequência, na barra de ferramentas, em “Editor”, clique em “Start Editing” e 

escolha o arquivo shape que se deseja editar. Abra novamente a tabela de atributos e 

acrescente as informações referentes a cada polígono na coluna previamente criada 

(“Morfoescul”), ou seja, o nome do compartimento morfoescultural. Salve suas edições 

em “Save Edits” na barra “Editor” e saia do modo de edição em “Stop Editing”. Como, 

provavelmente, seu arquivo shape possuirá muitos polígonos representando a mesma 

informação, utilize a ferramenta “Dissolve”, explicada na página 30 deste tutorial, para 

generalizar os polígonos semelhantes, escolhendo como atributo comum entre eles a 

coluna “Morfoesc”. O resultado final deve ser semelhante a este: 

 

 

 

 

 

 

 

 

 

 

 

 

5.4.2. Unidade Morfoestrutural Bacia Sedimentar do São Francisco 

A Unidade Morfoestrutural Bacia Sedimentar do São Francisco ocupa uma 

pequena área a nordeste do mapa, isto fez com que a diferenciação de morfoesculturas 

se tornasse limitada. Portanto, foi possível identificar nessa área a Unidade 

Morfoescultural Depressão do Rio Paranaíba, levando em consideração a altimetria 

rebaixada e a posição no Vale do Rio Paranaíba. O resultado deve-se assemelhar a este: 
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5.4.3. Unidade Morfoestrutural Bacia Sedimentar Cenozóica 

Semelhante à anterior, a Bacia Sedimentar Cenozóica ocupa uma pequena área a 

sudoeste do mapa, corresponde aos depósitos fluviais cenozóicos existentes em um 

trecho das margens do Rio Grande, tendo sido identificada a Unidade Morfoescultural 

Planícies Fluviais, conforme a figura a seguir: 

 

 

 

5.4.4. Unidade Morfoestrutural Faixa de Dobramentos 

Na Unidade Morfoestrutural Faixa de Dobramentos foi possível identificar, de 

acordo com os parâmetros de sombra e rugosidade, bem como pela análise do perfil 

topográfico, duas áreas distintas, uma com altitude > 1000 m e outra com altitude < 

1000 m. Desta forma, foram definidas as Unidades Morfoesculturais Planalto 

Dissecado (Faixa Uruaçu) e Planalto Dissecado da Serra da Canastra.  

 

 

 

 

 

 

 

 

 

5.4.5. Unidade Morfoestrutural Intrusões Dômicas/Ígneas 

A Unidade Morfoestrutural Intrusões Dômicas/Ígneas apresenta distintamente, 

formas evidentes de relevo proporcionados pela “ação intrusiva que foi responsável pelo 

soerguimento estrutural de estruturas em formas de chaminé, remontando 
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posteriormente formas de relevos circulares” (Ferreira, 2005). Desta forma, na área de 

estudo, encontram-se as Unidades Morfoesculturais Domo de Tapira, Domo de Araxá, 

Domo de Salitre, conforme observa-se na figura seguinte: 

 

 

 

 

 

 

 

 

 

 

 

5.5. Finalizando o mapa de Unidades Morfoesculturais 

Para visualizar o mapa completo de Unidades Morfoesculturais, basta selecionar 

na guia “Layers” todos os shapefiles referentes às Unidades existentes já classificadas. 

Desta forma, na vista do ArcMap deverá aparecer uma imagem semelhante a esta: 
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6. CRIAÇÃO DE LAYOUTS DE IMPRESSÃO/VISUALIZAÇÃO  

Os Layouts de mapas são importantes para melhorar a visualização e a 

apresentação do seu mapa. Em um Layout de impressão/visualização devem constar 

informações básicas sobre determinado mapa, a saber: título, legenda, rosa-dos-ventos, 

escala, coordenadas, informações de autoria, fonte, figuras externas, entre outros.  

Para a criação de Layout no ArcGis, devem-se seguir alguns passos: 

¨  Primeiramente, deve-se ajustar a imagem na vista do ArcMap de modo que 

ela apareça inteira ao máximo. 

¨  É necessário configurar o tipo de página para impressão. Para tal, na barra de 

ferramentas superior, em “File”, selecione “Page and Print Setup”. Abrirá 

uma nova janela, na qual, em “Paper” > “Size”, selecione o tamanho do 

papel que se deseja fazer a impressão, e em “Orientation” selecione a 

orientação do papel, a preferência é “Landscape” (Paisagem). 
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¨  Deve-se melhorar a redação dos shapes na guia de Layers, para que 

apareçam na legenda adequadamente. Por exemplo: se o shape referente à 

hidrografia está nomeado “rec_hidro”, deve-se editá-lo e renomeá-lo “Rede 

Hidrográfica”, etc. 

¨  Para entrar na tela de Layout, prossiga até a barra de ferramentas superior, 

em “View” clique em “Layout View” ou selecione na barra inferior da vista 

do ArcMap o ícone . 

Já na tela de Layout, é possível inserir os elementos citados anteriormente: título 

do mapa, legenda, rosa-dos-ventos, escala, coordenadas, informações de autoria, fonte e 

figuras externas. A maior parte destes elementos é inserida através do comando: barra 

de ferramentas superior > “Insert”. 

 

 

 

 

 

 

 

 

 

As coordenadas podem ser inseridas através do comando: barra de ferramentas < 

“View” > “Data Frame Properties”, abrirá uma janela, na qual, deve ser selecionada a 

aba “Grids”. Prossiga até a opção “New Grid” e em “Which do you want to create?” 

selecione o tipo de grade que se adéqua ao seu mapa, neste caso, é a opção “Measured 

Grids: divides map into a grid of map units” (referente ao sistema de coordenadas 

planas). O próximo passo é escolher o tipo de aspecto que se deseja inserir no mapa, em 

“Appearance” há três opções: uma grade retangular (“Grid and labels”), marcações em 

ponto (Tick marks and labels”) ou nenhum desses (Labels only). Em “Intervals” deve-se 

digitar os intervalos desejados para as coordenadas, ou simplesmente deixá-lo de acordo 

Inserir o Título do mapa. 

Inserir autoria, fonte, informações adicionais. 

Inserir Legenda. 

Inserir rosa-dos-ventos. 

Inserir escala gráfica. 

Inserir figuras externas. 
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com o que o programa colocou. Clique em “Avançar”. Na opção “Axes”, a critério do 

usuário, pode se selecionar ou não as opções que estabelecem eixos às coordenadas. Da 

mesma forma, no próximo passo, o usuário pode escolher se deseja contornos às 

coordenadas ao selecionar as opções de “Measured Grid Border” e “Neatline”. Clique 

em “Finish” e dê “Ok”. 

Nota sobre a legenda: A legenda específica oferecida pelo programa não satisfaz as 

necessidades de apresentação das informações contidas no esboço geomorfológico 

criado. Desta forma, será necessário, exteriormente ao ArcGis, criar uma legenda 

diferenciada, conforme a seguinte: 

 

 

 

 

 

 

 

 

 

Esta legenda foi criada no Microsoft Word como tabela comum, foi transformada em 

figura e suas cores foram editadas no programa Adobe Photoshop 7.0.1, de acordo com 

a coloração do mapa original do ArcMap. Após ter criado tal legenda, deve-se importá-

la para o ArcMap através da opção citada anteriormente: “Picture” (Inserir figuras). 

Deste modo, quando da inserção da Legenda “normal” pelo programa ArcGis, deve-se 

selecionar apenas os shapes referentes às Convenções Cartográficas, como por exemplo, 

a Rede de Drenagem e as Represas. 

Após a execução dos passos citados neste tópico, o Layout do seu mapa estará 

pronto. Então, na barra de ferramentas > “File”, selecione “Export Map” para exportar o 

seu mapa com outras extensões. A seguir uma demonstração de um Layout já 

produzido.
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